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3D Getting Started Tutorial 

This tutorial will guide you through 3D scene operations using some examples. 

SuperMap iDesktop 9DSpherical scene and plane scene are provided. Spherical scene 

simulates the globe in three-dimensional space . Plane scene simulate the globe 

in expanded plane. Plane scene is applicable to scenarios of small scene, such as 

communities, residential building representation, etc.  

Main Contents: 

Load 3D Models 

In this session, we will load building models of the Beijing Olympic Park to a 

newly created scene, and see how the real world can be depicted with SuperMap 

iDesktop 9D 

Step 1: Creating a New Scene 

1. Launch SuperMap iDesktop 9D.  

2. On the Start tab, in the Browse group, click the Scene drop-down button and 

click New Plane Scene to create an unnamed scene as shown in the following 

figure.  

 

Step 2: Loading Models to Scene 

1. In the Scenes tab and Data group, select Add Model on the Add Model drop-down 

list. The below dialog box is displayed. 

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DModel/LoadModel.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DModel/Step1_NewScene.htm
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2.Add Layer to save model. In the 3D scene, A single model can not be added 

directly to the scene, you need to select the existing KML layer or create a 

new KML layer as a carrier. Add model to the KML layer and then add to the 

scene. In this case, you need to create a new KML layer. Click New Layers to 

create a layer named OlympicGreen.  

3.Add Model: After creating KML layer, click Add Model and pop-up Open 3D 

Model File dialog box. Select model file and add to the KML layer. KML layer 

support for adding multiple model files, which types are: *.3ds, *.mesh, *.obj, 

*.x, *.dae, *.osg, *.osgb.  
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4.Modify Model Position. When the model is added to the list, the default file 

name is *.x, the default latitude and longitude values are the latitude and 

longitude coordinates of the current scene center point. If you know the 

location of the currently added model, you can move the mouse to the longitude, 

latitude column, click the left mouse button or press the F2 key to make it 

editable to change the latitude and longitude. If you don't know the location 

information, It is recommended that you prepare a map of the area where the 

model is located, superimposed on the model layer, the model is loaded into 

the scene, the image as a reference, set the KML layer can edit, select and 

move the model to the exact location. 

 

 Note 

A .kml layer is suitable for scenes with a relatively small number (<100) models 

with changing positions. A .kml layer can only be used for local browsing of 3D 

models, and cannot be used for model publishing on the web. 

Step 3: Saving the Layer 

When you finish adding models to a layer, you need to save the layer for future 

use. To achieve this, right click on the OlympicGreen layer under the General 

Layers node in Legend Manger and click Save. 

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DModel/Step3_SaveLayer.htm
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Step 4: Distributing Model Data 

If the KML layer has been saved, you only need to add the KML layer from Legend 

Manger next time you want to add models contained in the KML layer to a scene. 

You can distribute model data When you want to distribute model data among 

machines. To ensure data integrity and consistency, you need to distribute the 

layer file and model files at the same time and ensure that the relative path of 

the layer file to models files remain consistent. 

You can add a model layer to a scene with 

Method 1: Click KML drop-down button on the scene tab and Data group, select Load 

KML... and pop-up Open KML File dialog box. Select the saved model layer, click 

Open button to load model layer. 

Method 2: Right click on the Genreral Layers node in Layer Manager, click Add KML 

Layer to display the Open KML Data dialog box, navigate to the folder where the 

KML layer you want to add to the scene is located, highlight the file, and then 

click Open. 

Load Data 

Create a scene, add terrain caches, images, KML to the scene, and browse the 

scene you added. Finally save the scene. 

Step 1: Create a new scene 

1. Start SuperMap iDesktop 9D application.  

2. Create a scene. You can go to Start Tab>Browse Group>Scene, click the 

dropdown arrow, click New Spherical Scene; or right click Scenes node in 

Workspace Manager, and click New Spherical Scene in the context menu that 

display.  

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DModel/Step4_DistributeModel.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/SceneApplication/Application1.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step1_NewScene.htm
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3. The new scene is shown as below:  

 

4. If you need to load global framework data, you can go to File>Options, 

check Load frame data automatically when creating a new scene on the 

General page. SuperMap iDesktop 9D The frame data is included with the 

package. Therefore, after you create a new scene, there will be some data 

for the globe, as shown below: 
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Step 2: Load data 

Add terrain cache data, image cache data and model data to the scene. SuperMap 

iDesktop 9D All the data here are the sample data in iDesktop package. 

Add Terrain Cache Data 

1. Click on the Scene tab, find the Data group and click on the Cache button, or click on the drop-down list of Cache and click 
on Load Cache...; Or right click the node Terrain Layers in Layer Manager, and choose Add Terrain Cache Layer...  

2. A Open 3D Cache File dialog box pops up.  
3. Find the terrain cache data (*.sct) that you want to load. In this sample, we choose JingjinTerrain.sct which is generated by 

JignjinTerrain data, and click Open in the dialog box.  
4. After the terrain caches are added, there is a sub-node appears under the node Terrain Layers. This sub-node is the terrain 

cache data you created. The effect of adding the terrain caches to the scene is shown as follows.  

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm#222
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap iDesktop 9D Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm


 

 7 / 14 

Add: 6/F, Building 107, No. A10, Jiuxianqiao North Road, Chaoyang District, Beijing, 100015, CHINA, 100015 
E-mail: request@supermap.com      Website: www.supermap.com 

 

For more knowledge about terrain cache, please see Generate 3D Terrain Cache. 

Add Image Cache Data 

1. Click on the Scene tab, find the Data group and click on the Cache button, or click on the drop-down list of Cache and click 
on Load Cache...; Or right click the node General Layers in Layer Manager, and choose Add Image Cache Layer...  

2. A Open 3D Cache File dialog box pops up.  
3. Find the image data you want to load, choose this file and click Open in the dialog box. SuperMap supports the following 

types of image cache: *.sci, *.sci3d, *.sit, and *.tiff. In this sample, we add *.sci cache file.  
4. After the image caches are added, there is a sub-node appears under the node General Layers. This sub-node is the image 

cache data you created.  

 

 For more knowledge about image cache, please see <>Generate 3D Image Cache. 

<> View Scene 

1. In Layer Manager, double click on the image cache layer under General Layers. You can fly to the geographical bounds of 
the image cache data in the scene.  

2. The quarter circle with a small round button, as shown in figure A, controls the angle from which you view the scene. 
Placing the small round button to the top creates a scenario that you view the scene from above. While when you drag the 

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/Features/Optimization/Cache/TerrainCache.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/Features/Optimization/Cache/TerrainCache.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm#222
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/Features/Optimization/Cache/ImageCache.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/Features/Optimization/Cache/ImageCache.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/Features/Optimization/Cache/ImageCache.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/Features/Optimization/Cache/ImageCache.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap iDesktop 9D Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm
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button along the quarter circle to the right, the scene will be displayed vertical to the screen. You can also place the button 
at any other position on the quarter circle to get a best presentation of the terrain in the area of your interest.  

Besides, you can drag up or down with the middle mouse button to change the 

angle of your view. 

3. By clicking the button with a plus sign, as shown in figure B, you can zoom in the scene. And you can click the button with a 
minor sign to zoom out the scene.  

Besides, you can zoom in or out of a scene by scrolling up or down in the 

scene. 

4. By clicking the up, down, left, and right arrow keys on the navigation compass, as shown in figure C, you can pan the scene.  

Besides, you can click and drag toward a specific direction in the scene to 

achieving panning the scene. 

5. By placing the button with a capitalized character N at different positions on the circle, as shown in figure D, you can 
change the North direction of the scene. When you click and drag the N button along the circle, the North direction of the 
scene is changed and the scene rotates accordingly, presenting you views of the scene in different directions.  

Besides, you can drag left or right with the middle mouse button to change 

the north direction of the scene. 

 

 Set Terrain Exaggeration 

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm#222
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Terrain Scale on the Scene Properties panel can be used for setting 

vertical exaggeration rate of terrain. In other words, how many times you 

want to exaggerate the terrain. You can input a number in the text box. 

Here we set the terrain exaggeration scale is 2.5 times. Shown as below, 

the terrain outlines are more clear after it is exaggerated. 

 

Add CAD Model Dataset 

1. Choose File -> Sample Data -> CBD Scene.  
2. Select the CAD model data, and add it to the spherical scene. It is shown as follows.  

 

For more information about CAD model dataset, please see CAD Model Dataset. 

Step 3: Save scene 

There are two methods to save the scene: 

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm#222
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/Features/DataProcessing/DataManagement/DataFormats/CADModelDataset.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step3_SaveScene.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap iDesktop 9D Help.chm::/GettingStarted/QuickMakingSceneTutorial/Load3DData/Step2_LoadData.htm
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 1: Save the scene to the workspace  

Right click to select Save Scene in the scene window. If it is the first 

time to save scene, it will pop up a dialog, input the scene name and click 

OK. The scene will be saved in the workspace. After the workspace is saved, 

the scene will be saved in the existing workspace. 

 2: Save scene as  

1. Select the scene node in workspace manager, right click to select 

Save Scene As....  

2. Input the name of the new scene, click OK.  

3. Then a new scene node will be added to the workspace manager.  

4. Also it's noticed that the workspace must be saved.  

Fast Modeling 

In this example, we will introduce how to build 3D models based on a 2D region 

dataset depicting a group of buildings. 

 Step 1: Creating a New Scene and Adding Data to the Scene 

1. Start SuperMap iDesktop 9D .  

2. Open the Residents.udb datasource where the Buildings region dataset 

depicting a group of buildings is located.  

3. Create a new scene. To achieve this, you can click the Scene drop-down 

button in the View group on the Start tab, and then click New Scene in the 

drop-down list that appears. Also, you can right click on the Scenes node 

in Workspace Manager and click New Scene in the context menu that appears.  

4. Add the Buildings region dataset to the newly created scene.  

To achieve this, you can lick and drag the Buildings dataset from Workspace 

Manager into the scene. Also, you can righ-click on the Buildings dataset 

under the Residents datasource node in Workspace Manager, and then click 

Add to Current Scene in the context menu that appears. 

5. When finished, a child node named Buildings, which is corresponding to the 

newly added Buildings region dataset, shows up uner the General Layers node 

in Layer Manager. You may want to display the full extent of the Buildings 

layer, then you can double-click the layer node in Layer Manager. Meanwhile, 

you can perform various browse operations in the scene. For instance, you 

can adjust for an appropriate direction to view the group of buildings by 

dragging the N button along the circle on the Navagation Compass, which is 

positioned on the upper right of the scene.  

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/SceneApplication/Application3.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/SceneApplication/Application3Step1.htm
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Step 2: Rapid Modeling 

Rapid 3D modeling is essentially vertically extending a 2-dimensional region 

dataset into 3 dimensions. To achieve this objective, you need to specify the 

stretched height, top texture, side texture, etc. Now let us see how to create a 

3D model from the Buildings region dataset. 

1. Set the Buildings region dataset as the current layer.  

2. In the Extension group on the Styles tab, select and set the Altitude Mode 

as Relative to Ground.  

The extend operation can only be performed on a 2D dataset when it is not 

in the Clamp to Ground altitude mode. 

3. In the Extension group, click the Mode drop-down arrow to set the altitude 

of region object. The unit is meter and here it is 35.  

In the Extension group, click the Exended Height drop-down arrow to select 

a field in the attribute table of the Buildings datset specifying the 

extended heights for each geometric obejcts. If you have not created such a 

field in the attribute table and you want to sepcify a common extended 

height for all gemetric objects in the layer, then you can manually type in 

a value to specify how many units you want to vertically extend all the 

regional objects. The unit for Extended Height in SuperMap iDesktop 9D is 

meter. 

4. In the Extension group, click the Texture Mapping button. You can set the 

SideTexture and TopTexture of region object in 3D Mapping Manage.  

o In the Top Texture group, click the Texture Source drop-down arrow to 

select a text filed in the attribute table of the Buildings dataset 

specifying the full paths of texture maps, with which you want to 

paint to top of each extended object.  

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/SceneApplication/Application3Step2.htm
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o If you have not created such a field in the attribute table and you 

want to specify a common top texture map for all the extended objects 

in the layer, then you can click Select in the drop-down list to 

display the Select a Texture Map dialog box, navigate to the picture 

you want to apply, highlight it and click OK.  

o Here we click click the Top Texture drop-down arrow in the Extending 

and Mapping group, click Select to display the Select a Texture Map 

dialog box, navigate to the folder where TopTexture.jpg we intend to 

apply is located, highlight it, and click OK.  

o The method of side tuxture is the same as top texture. Here we are 

using the uniform picture as the side tuxture, namely, selecting the 

SideTexture in the drop down arrow. The picture files 

(SideTexture.jpg) are saved in the SideTexture field.  

5. In 3D Mapping Manage, Tiling U and Tiling V use the default value 1. Repeat 

Mode uses the default value Repeat Times.  

6. Click the Styles tab. In the Fill Style group, click the Fill Color button 

to set the fill color to white, and click the drop-down arrow next to Fill 

Mode to set the fill mode to Fill.  

7. When finished, adjust for an appropriate direction and view angle to 

present the newly created 3D model.  

 

Step 3: Saving the Scene 

You can save the scene use either the Save or Save as commands. For more detailes, 

please refer to steps on Saving the Scene introduced in Example 1. 

Shortcut Keys for Scene Operations 

Shortcuts provided by SuperMap iDesktop for Scene operations are listed below. 

mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/SceneApplication/Application3Step3.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/QuickMakingSceneTutorial/SceneApplication/Application1Step3.htm
mk:@MSITStore:C:/Users/Administrator/Desktop/英文/SuperMap%20iDesktop%209D%20Help.chm::/GettingStarted/SceneOperation/SceneShortcutKey.htm
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Shortcut Description 

N Restore the heading angle 

R Restore the heading angle and FOV. 

F6 Entire Globe 

F11 Full Screen 

Page Up Camera zoom in 

Page Down Camera zoom out 

← or A Move left 

→ or D Move right 

↑ or W Move forward 

↓ or S Move backward 

Alt + Move Key Lower the steps (to the 1/4) 

Alt + Middle Mouse 

Button 

Rotation with the click point as the 

center 

Ctrl + ← 
Turn left from the view of first 

person 

Ctrl + → 
Turn right from the view of first 

person 

Ctrl + ↑ 
Turn downward from the view of first 

person 

Ctrl + ↓ 
Turn upward from the view of first 

person 

Ctrl + Middle Mouse 

Button 

Adjust the angle of inclination from 

the view of first person 

Shift + ← or Shift 

+ A 

The center point is the viewing 

angle of rotating the camera 

anticlockwise. 

Shift + → or Shift 

+ D 

The center point is the viewing 

angle of rotating the camera 

clockwise. 

Shift + ↑ or Shift 

+ W 

The center point is the viewing 

angle of lowering the camera 

Shift + ↓ or Shift 

+ S 

The center point is the viewing 

angle of raising the camera 

Shift + Middle 

Mouse Button 

The center point is the target 

camera angle. 

Middle Mouse Button 

1. When Tilt angle is 0 or 90 or can 

not adjust because of terrain, it 

will transition to first person 
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Shortcut Description 

view. 

2. When press the Middle Mouse 

Button and drag to decrease the tile 

angle, it will transit to the 

general mode automatically. 

Ctrl + + Seeed up 

Ctrl + - Slow down 

J 

You can add the current camera 

position as a new observation point 

to the current flight route. 

 


